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ACIKLAMALAR

ALAN Bilisim Teknolojileri
DAL / MESLEK Veri Tabam Programcihigi
MODULUN ADI Gellsinls Internet Uygulamalari ile Tarayici Islemleri ve
Arayiiz Olusturma
Gelismis internet uygulamalari ile tarayici islemlerini
MODULUN TANIMI g.erc;'eklestlr.mek ve kullanici arayiizii olustl'lrrnnvak icin gerekli
bilgi, beceri ve tutumlarin kazandirildigi bir 6grenme
materyalidir.
SURE 40/32
ON KOSUL
YETERLIK Tarayici .1$lemler1n1 yapabilmek ve kullanici arayiizii
hazirlayabilmek.
Genel Amac
Bu modiill ile; gerekli ortam sagladiginda yazilim
gelistirebileceksiniz.
MODULUN AMACI Amaclar
1. Tarayic1 iglemlerini gerceklestirerek sayfa olaylarini
diizenleyebileceksiniz.
2. Kullanic arayiiziinii programlayabileceksiniz.
EGITIM OGRETIM Ortam: Bilgisayar laboratuvari
ORTAMLARI VE Donanim: Animasyon diizenleme yazilimini ¢alistirabilecek
DONANIMLARI yeterlikte bilgisayar
Modiil i¢inde yer alan her grenme faaliyetinden sonra verilen
6lgme araglar ile kendinizi degerlendireceksiniz. Ogretmen,
OLCME VE modiil sonunda 6lgme araci (¢oktan segmeli test, dogru-yanlig
DEGERLENDIRME testi, bosluk doldurma, eslestirme vb.) kullanarak modiil

uygulamalari ile kazandiginiz bilgi ve becerileri dlcerek sizi
degerlendirecektir.




GIRIS

Sevgili Ogrenci,

Her gecen giin Onemini artiran ve yayginlasan XAML tabanli zengin internet
uygulamalariyla calisirken en sik karsilasacaginiz konulardan ikisi tarayici islemlerini
yonetebilmek ve kullanici arayiizleri hazirlamaktir.

Tarayici iizerinden c¢alisan tiim uygulamalarin verimliligi ve islevselligi tarayici
kaynaklarinin etkin kullanimima baglidir. Modiiliin icerisindeki konular1 tamamladiginizda
uygulamanizin saglikli ve sorunsuz bigimde ¢alismasini saglayacak adimlari atabileceksiniz.

Kullanicilar agisindan bir uygulamanin en 6nemli kismi siliphesiz arayiiziidiir. Bu
modiilden faydalanarak arayliz elemanlarinin rolleri, kullanim alanlar1 ve birbirleriyle
iligkilendirilmeleri konularinda bilgi ve beceri sahibi olabileceksiniz.

Gelismis internet uygulamalari olusturabilmek i¢in kullanilabilecek ¢ok sayida farkl
iiriin mevcuttur. Bu modiilde siire¢ XAML teknolojisi lizerinden ele alinacaktir.

Internet iizerinde performans: yiiksek ve gorselligi yiiksek uygulamalar
gergeklestirmek igin iyi bir kaynak olabilecek bu modiilii bagariyla tamamlamaniz dilegiyle.






OGRENME FAALIYETIi-1

( AMAC )

Tarayici islemlerini gergeklestirerek sayfa olaylarini diizenleyebileceksiniz.

(ARASTIRMA )

> Yaygin internet tarayicilarini inceleyerek benzerlik ve farkliliklarini tespit
ediniz.

> Bir internet tarayicisinin yerine getirmesi gereken gorevleri tartisiniz.

> Arkadaslarinizin  internette  gezinirken hata mesajlartyla  karsilasip
karsilasmadiklarini, karsilagsmiglarsa mesajlarin ne tiir icerigi oldugunu
arastiriniz.

> Yazilimlarin neden hata mesajlart hazirladigini tartiginiz.

1. TARAYICI ISLEMLERI

1.1. Tarayic1 Yazilhminin Rolii

Internet sayfalarin1 goriintiilemeyi saglayan tarayici yazilimlari, sade goriiniislerinin
arka planinda oldukca karmasik ve &nemli islemler yerine getirir. Gelismis Internet
uygulamalari tarayici iizerinde ¢alisan yazilimlardir. Bu nedenle tarayici yazilimiyla devamli
olarak etkilesim halindedir. Ayrica tarayict yazilimi, [nternet uygulamalarinin
gerceklestiremeyecegi bazi islemleri yerine getirebildiginden, yapabileceklerimizin
sinirlarini genisletmek konusunda da is birligi yapacagimiz bir sistemdir.

Web Tarayia Icerisinde Silverlight Sunucusu Silverlight Uygulamasi XAML
Silverlight Eklentisi HTML/ASPX Sayfasi XAP Dosyasi

Resim 1.1.: XAML uygulamalarinin tarayicida ¢calisma prensibi



XAML tabanli gelismis internet uygulamalarinda tarayici yazilimi kullanicinin
dogrudan etkilesime gectigi kisimdir. Uygulamanin tarayici tarafindan kullanicinin
bilgisayarina yiiklenmesi ve hatasiz bir sekilde calistirilabilmesi son derece Onemlidir.
Muhtemel hata durumlarinda ise kullanicinin dogru ve yeterli bir sekilde bilgilendirilmesi ve
yonlendirilmesi gereklidir.

1.2. Sayfa Yiikleme Olaylari

1.2.1. Sayfa Yiikleme

Resim 1.2: Sayfa yiikleme

Bir internet sitesine baglandiginizda tarayici yazilimi, adres satirinda belirlediginiz
web sunucusuna baglanarak sayfanin goriintiilenmesi i¢in gerekli tiim igerigi sunucudan alir
ve bu igerigi ongoriilen formatta gorintiiler. Bu siireci sayfanin yiiklenmesi olarak ifade
edebiliriz.

Resim 1.1.’de gosterildigi izere XAML tabanli internet uygulamaniz “.XAP” uzantih
bir dosyadir. Dolayisiyla XAML uygulamasi bulunan bir sayfanin yiiklenmesi, ilgili XAP
dosyasinin indirilip goriintilenmesi demektir. Geligsmis internet uygulamalar1 zengin igerik
saglamaktadir. Bu nedenle XAP dosyas! biiyiik bir veri ihtiva ediyor olabilir. Ozellikle
video, resim, animasyon gibi ¢oklu ortam 6geleri igeren gelismis internet uygulamalarinizin
yiiklenmesi esnasinda kullanicilar uzun siire beklemek zorunda kalabilir.

11%

Resim 1.3: Sayfa yiikleme animasyonu

Ozellikle Internet ortaminda hizin son derece onemli oldugu giiniimiizde,
kullanicilarin yiikleme islemi sirasinda uygulamaniza odaklanmalarini saglamak igin
“Yiikleme ekranlar1i (SplahScreen)” hazirlamak iyi bir yontemdir. Resim 1.3’te sayfa
yiikleme esnasinda goriintiilenen varsayilan yiikleme animasyonu goriilmektedir.

1.2.2. Yiikleme Sayfasinin Calisma Prensibi

Yiikleme ekranlar1 ¢ok cesitli olabilir. Ornek olarak Internet uygulamalarinda en
yaygm olarak gordiigiimiiz, yiikleme islemindeki ilerlemeyi kullaniciya yiizdelik deger
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olarak bildiren basit gecis sayfalarn tasarlanabilir. Yiikleme ekranimi uygulamanizla
bagdastirmay1 6grendikten sonra hazirlayabileceginiz farkli ylikleme ekranlar1 yalnizca hayal
giicliniizle sinirhdir.

Kendi ylikleme ekranimizi hazirlarken ti¢ 6zelligi kullanmak gerekecek:

Hazirladigimiz  yiikleme sayfasinin yolunu,
splashscreensource: | hmtl dosyasina bildirirken kullanacagimiz
parametredir.

Yiikleme isleminde ilerleme gerceklestiginde
OnSourceDownloadProgressChanged | (etiklenerek caligan JavaScript olayidir.

Yikleme islemi tamamlandiginda tetiklenen

OnSourceDownloadComplete JavaScript olayidr.

Tablo 1.1: Yiikleme parametre ve olaylari

Hazirlanacak yiikleme animasyonu sayfasi projenin web tarafinda yer almalidir.
Boylece kullanicinin erigim istegine oncelikle bu sayfa yiiklenerek cevap verilecektir.
Hazirladigimiz sayfa igerisinde, Tablo 1.1°de gdsterilen JavaScript olaylar1 sayesinde asil
uygulamamizin  tiim verilerinin aktarilip aktarilmadigi  kontrol edilecektir. Islem
tamamlandiginda, asil uygulamamiz tarayici yazilimi tarafindan goriintiilenecektir.

HT VUKL
o e,

Resim 1.4: Yiikleme ekrani ¢alisma ilkesi



1.2.3. Yiikleme Sayfas1 Hazirlama

New Silveright Applcation T -

| Oick the checkbox below %o host this Silverlight application in 8 Web site. Otherwise &
test page will ke generated during build

v Hest the Sverhight application = a mew Web site
New Webd project name:
YullemeSayfan. Webd
New Wed project hype

ASP.NET Wed Apphcation Progect -

| Options
|| Shverlight Version

Schwhghu -

Enable WCF RIA Services

Resim: 1.5: Yiikleme sayfas1 hazirlama

[k olarak Visual Studio 2010 igerisinde yeni bir Silverlight uygulamasi olusturalim.
Uygulamamizin ismini “YuklemeSayfasi” olarak belirleyelim.

Web projemiz icin ¢esitli ayarlamalar yapabilecegimiz bir iletisim kutusu
goriintiilenecektir.

Resim 1.5’te gosterildigi iizere varsayilan ayarlarda herhangi bir degisiklik yapmadan
devam edelim.



Solution Explorer W S C

2| DE S| e
‘2 Solution "YuklemeSayfasi' (2 proj
4 “EYuklemeSayfasi
=d| Properties
<3 References
e Appxaml
| MainPage.xaml
4 |“® YuklemeSayfasi.Web
=d| Properties
«J| References
[ ClientBin
i3] Silverlight.js
i Web.config
‘E| YuklemeSayfasiTestPage.
#] YuklemeSayfasiTestPage.

Resim 1.6: Yiikleme sayfasi hazirlama

Ekranin sag kisminda yer alan “Solution Explorer” boliimiinde projemiz igerisinde yer
alan tiim dosyalar goriintiilenmektedir.

Bu kisimdan YuklemeSayfasi.Web {izerinde sag tiklayalim. Agcilan meniide
“Properties” secenegine tiklayalim. Bdylece web projemiz igin gerekli ayarlamalari
yapabilecegimiz arayliz goriintiilenecektir.

Sol kisimdaki “Web” sekmesini segtigimizde, projemizin “SpecificPage” 6zelliginin
“YuklemeSayfasiTestPage.aspx” olarak belirlenmis oldugunu gorebiliriz.

Bu kisimdan SpecificPage 6zelligini  “YuklemeSayfasiTestPage.html” olarak
degistirelim.

9 Specific Page YuklemeSayfasiTestPage html - ’

Resim 1.7: Yiikleme sayfasi1 hazirlama

Boylece, varsayilan olarak aspx tiiriinde tanimlanan web sayfasini devre dig1 birakmig
oluyoruz. Projemizi HTML iizerinden calistirmamiz yeterli olacaktir. Web projemize
yiikleme ekrani olarak kullanacagimiz sayfay1 ekleme agsamasina gelmis bulunuyoruz. Tekrar
YuklemeSayfasi.Web iizerinde sag tiklayarak sirasiyla “Add”, “New Item” segeneklerini
segelim.




“Add New Item” penceresinden sol tarafta bulunan Silverlight sekmesini
isaretledikten sonra “Silverlightl.0 JScript Page” dosyasini secelim. Sayfamizi
“YuklemeSayfam.xaml” olarak isimlendirelim ve “Add” butonuna tiklayalim.

SE—— |
Add New ltem - YuklemeSayfasiWeb ||
l Installed Templates Sort by: | Default = [k Search Installed Templates ol
4 Visual C= .
Type: Visual C&
Code Silverlight Test Class Visual C% ype: Tisua
Data v A JScript page which targets Sikverfight 1.0
General i“'( Siverlight 1.0 IScript Page Visual C=
Web =
=
Windows Ferms Dﬂ Silverlight Application Visual C2
WPF “
Reporting ﬂ Sitverlight-enabled WCF Service Visual C&
Sibverlight
Warkflow
Onlire Templates
Marme: WuklerneSayfam|xarmi

T T

Resim 1.8: Web projesine yiikleme sayfasinin eklenmesi

Sag kisimdaki Solution Explorer penceresinde “YuklemeSayfam.xaml” ve
“YuklemeSayfam.js” isimlerine sahip iki yeni dosyanin daha yer aldigin1 gérebilirsiniz.

Eger otomatik olarak diizenlemek {izere goriintiilenmemis ise Solution Explorer
penceresinden secerek YuklemeSayfam.xaml dosyamizi agalim. Halihazirda bir kod
blogunun sayfamizda var oldugunu gorebiliriz. Sayfadaki tiim kodlar1 silelim. Bu noktadan
sonra tamamen isteginize gore bir yiikleme sayfasi i¢in gerekli XAML kodlarimi sayfaniza
eklemelisiniz.

Bizim Ornegimizde, yiikleme islemindeki ilerlemeyi yiizdelik degerler olarak
gostermek tlizere iki adet TextBlock, bir elips sekli ve yiikleme ilerlemesini temsil edecek
bicimde eni artacak bir dikdortgen seklinden olusan bir sayfa tasarimi yapacagiz.



YuklemeSayfam.xaml dosyasi i¢in asagidaki kodlar1 kullanalim:

<Canvas
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation”

xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"

xmlns:d="http://schemas.microsoft.com/expression/blend/2008"

xmlns:mc="http://schemas.openxmlformats.org/markup-
compatibility/2e06"

mc:Ignorable="d"

d:DesignHeight="300" d:DesignWidth="400">

<Ellipse Canvas.Left="132" Canvas.Top="100" Height="84"
Stroke="Black" Width="84" Fill="#FF4BCB12" StrokeThickness="5"/>

<TextBlock FontSize="20" Canvas.Left="174" Canvas.Top="126"
Height="23" Text="0" x:Name="textBlockl" FontWeight="Bold"
Foreground="#FFF1F8EE" />

<TextBlock Canvas.Left="145" Canvas.Top="126" FontSize="20"
FontWeight="Bold" Height="23" Text="%" Width="25"
Foreground="#FFF3F8F1" />

<Rectangle Canvas.Left="123" Canvas.Top="195" Height="11"
Stroke="Black" Width="100" Fill="Black" />

<Rectangle x:Name="cubuk" Canvas.Left="122" Canvas.Top="195"
Height="11" Stroke="Black" Width="7" Fill="Red" />
</Canvas>

Kodlarimizi sayfamiza ekledikten sonra artik uygulamamiz yiiklenene kadar
kullanicilara gosterilecek yiikleme sayfamiz hazirdir. Bir sonraki asamada hazirladiginiz
sayfay1 web projenizin html sayfasi icerisinden ¢agirmaniz gerekir.

Solution Explorer penceresinde diizenlemek iizere “YuklemeSayfasiTestPage.html”
dosyasina ¢ift tiklayalim. Kodlari inceledigimizde uygulamamizin  <object> etiketleri
arasinda tanimlandigini gorebiliriz. Bu kisimda var olan “param” etiketlerinin altina
asagidaki satirlar ekleyelim:

<param name="splashscreensource"value="YuklemeSayfam.xaml"/>

<param name="onSourceDownloadProgressChanged"
value="onSourceDownloadProgressChanged"/>

[k satirdaki kod sayesinde daha &nce Tablo 1.1°de belirtmis oldugumuz
splashscreensource 6zelligini belirlemis oluyoruz. Varsayilan yiikleme sayfasi yerine bizim
hazirladigimiz YuklemeSayfam.xaml sayfasinin ¢agrilmasini sagliyoruz.



Ikinci satirda ise yiikleme islemini denetleyecek bir JavaScript olay1 ¢agirilmaktadir.
Bu JavaScript olayin1 tanimlamak i¢in Solution Explorer penceresinden
YuklemeSayfasiTestPage.html isimli dosyay1 diizenlemek tizere agalim. Bu dosyadaki

<script type="text/javascript">
</script>

bloklar1 arasinda bir takim JavaScript kodlar1 mevcuttur. Bu JavaScript kodlarinin
altina agagidaki metod kodlarini yaziniz.

function onSourceDownloadProgressChanged(sender, eventArgs)
{
sender.findName("textBlockl").Text =
Math.round((eventArgs.progress * 100), 0).toString();
sender.findName("cubuk").Width = eventArgs.progress*100;
}

Tanimladigimiz bu onSourceDonwloadChanged fonksiyonu ile YuklemeSayfam.xaml
sayfamiz icerisindeki TextBlock nesnemizde goriintiilenecek degeri ve ilerlemeyi temsil
edecek dikdortgen nesnesinin genisligini giincelleyecegiz.

EventArgs.Progress 6zelligi i¢inde yiikleme ilerlemesi degeri bulunur. Bu deger O ile
1 arasinda bir degerdir. % cinsinden ifade etmek icin Progress degeri 100 ile ¢arpilmistir.
Hem textBlockl iizerinde gosterilmis hem de alttaki yatay cubuk seklindeki dikddrtgenin
genislik 6zelligi bu degere gore artmugtir.

Boylece kendi yilikleme sayfamizi hazirlamak icin gerekli adimlari tamamlamis
oluyoruz. File mentisiinden SaveAll segenegine tiklayarak tiim dosyalarimizi kaydedelim.
Projenizi derleyerek (F5 Kisayolunu kullanabilirsiniz) yiikleme sayfanizin isleyisini test
edebilirsiniz.

Resim 1.9: Yiikleme animasyonunun goriintiisii

Yiikleme sayfalarmi olusturma amacimizin biiyiik miktarda veri aktarilirken
kullanictyr bilgilendirmek oldugunu hatirlayalim. Bu yiizden hazirladiginiz yiikleme
sayfasini denerken resim, ses, video gibi biiylik miktarda verilerden olusan bilesenler iceren
bir gelismis /nternet uygulamasini kullanmalisiniz.
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1.3. Sayfa Hata Olaylar ve Hata Ayiklama
1.3.1. Hata Yonetimi

Yazilim gelistirme siireci de ¢ok sayida degiskene bagl ve oldukca kompleks islemler
gerektirir. Bu nedenle her yazilimin bir hata yonetimi boyutu vardir. Bu durum bizim
konumuz olan gelismis /nternet uygulamalar i¢in de gegerlidir.

Bir kullanic1 olarak kullandigimiz uygulamanin bir hataya sebep olmasi durumunda
sizi haberdar etmesini, sorunun nereden kaynaklandigini agiklamasini ve miimkiinse bu
sorunu nasil c¢ozebileceginize dair sizi yoOnlendirmesini beklersiniz. Hata yonetimi,
uygulamalarimiz i¢in bu islevleri yerine getiren bir destek mekanizmasi1 kurmak anlamina
gelir.

Message from webpage lihj

Unhandled Error in Silverlight 2 Application
/B Code:8001

Category: InitializeError

Message: 8001 An error has occurred.

Lo |

S

Resim 1.10: Ornek bir Silverlight hata mesaji
1.3.2. Hata Tiirleri

Hatalar farkli durumlardan kaynaklanabilir. Programcinin tiim olasi ihtimallere
karsilik uygun bir tepki hazirlamamis olmasindan, yani istisnalar bulunmasindan
kaynaklanan hatalara “Istisna (Exception)” adi verilir. “Exception” terimi artik her tiir hata
durumunu ifade eden genel bir ifade haline gelmistir.

Hatalan gergeklestikleri zaman gore soyle siniflayabiliriz:

Kod yazimindan kaynakli, uygulamanin
Derleme Hatalar1 (Compile Errors) calistirilmasindan 6nce meydana gelen
hatalar
Calisma Zamani Hatalar1 (Runtime Uygulama calistirildiktan sonra meydana
Errors) gelen hatalar

Tablo 1.2 HatalariN gerceklestikleri zamana gore simiflanmasi

Hatalar kaynaklandiklart nedenlere gore de cesitlilik arz eder. Uygulamanizin
niteligine gore gergeklesme olasilig digerlerinden daha yiiksek olan durumlar i¢in kendi hata
yOneticinizi diizenlemek isteyebilirsiniz.
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Web projemizin HTML sayfasinda Silverlight uygulamamiza ait <object> etiketleri
icerisinde varsayilan olarak bir hata igleyici fonksiyon tanimlanmustir.

<param name="onError"value="onSilverlightError"/>

Aym1 HTML sayfa igerisinde bu satirda isaret edilen “onSilverlightError” isimli
JavaScript fonksiyonu ise soyle tanimlidir:

<script type="text/javascript">
function onSilverlightError(sender, args) {
var appSource = "";
if (sender != null && sender != @) {
appSource = sender.getHost().Source;

}

var errorType = args.ErrorType;
var iErrorCode = args.ErrorCode;

if (errorType == "ImageError" || errorType == "MediaError")
{
return;
}
var errMsg = "Unhandled Error in Silverlight Application " +

appSource + "\n" ;

errMsg += "Code: "+ iErrorCode + " \n";
errMsg += "Category: " + errorType + " \n";

errMsg += "Message: " + args.ErrorMessage + " \n";
if (errorType == "ParserError") {
errMsg += "File: " + args.xamlFile + " \n";
errMsg += "Line: " + args.lineNumber + " \n";

errMsg += "Position: " + args.charPosition + " \n";
}
else if (errorType == "RuntimeError") {
if (args.lineNumber != 0) {
errMsg += "Line: " + args.lineNumber + " \n";
errMsg += "Position: " + args.charPosition + "
\nll;
}
errMsg += "MethodName: " + args.methodName + " \n";
}
throw new Error(errMsg);
}
</script>
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Cesitli hata tiirleri icin hatanin nitelik ve kaynagina dair bildirimler iireten bu
JavaScript fonksiyonunu kendi ihtiyaglariniza gére yeniden diizenleyebilir ya da tamamen
yeni bir fonksiyonu bastan yazarak projenize dahil edebilirsiniz.

1.3.3. Hata Ayiklama

Dogas1 geregi hatalara oldukca agik olan uygulama gelistirme siirecinde problemleri
tespit etme ve diizeltme islemine “hata ayiklama”(debugging) ad1 verilir. Bu modiilde konu
edindigimiz Silverlight teknolojisi ile uygulama gelistirirken Visual Studio 2010 icerisinde
bulunan Hata Ayiklayici (Debugger) 6zelligi size ¢gok yardimci olacaktir.

Hata ayiklayici1 hem uygulamanizi kodlarken hem de ¢alisma zamaninda denerken
problemleri denetleyecek ve size ayrintili raporlar sunacaktir. Bu 6zellik varsayilan olarak
aktif degilse aktiflestirmeniz gerekir.

2| DE|a|w
3 Solution 'HataOlaylari' (2 project
4 3 HataOlaylari
=d| Properties
«Jl References

| App.xaml
« MainPagexaml|
4 “® HataOlaylari.Web
=d| Properties
«3| References
| ClientBin
‘Z| HataOlaylariTestPage.asp
] HataOlaylariTestPage.htn
i3] Silverlight.js
i Web.config

Resim 1.11: Web projesi se¢me
[k olarak Visual Studio 2010 igerisinde, sag kisimda bulunan Solution Explorer
penceresinden Web projemizi secelim ve sag tiklayalim.

Acilan meniide en alt kisimda bulunan “Properties” segenegine tiklayarak devam
edelim.

Ekranda goriintiilenen “Properties” penceresinde sol kisimdan “Web” sekmesini
secelim. Bu sekmede sayfanin en altinda yer alan “Debuggers” alaninda “Silverlight”
secenegini isaretleyelim ve projemizi kaydedelim.
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Application
Build

.
Web @ Auto-assign Port
Package/Publish Web Specific port
Package/Publish SQL Virtual path:

Silverlight Applications NTLM Authentication

Use Local BS Web zerver

Build Events
Resources RO
Settings
Reference Paths
Use Custom Web Server
Signang
Code Analysis
Debuggers
7] ASP.NET Native Code SQL Server 7] Sivertight

Enable Edit and Continue

Resim 1.12: Kaydetme

Hata ayiklama islemlerine iliskin detayli bilgiyi Gelismis Internet Uygulamalarinda
Dinamik Programlama modiiliinde bulabilirsiniz.
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UYGULAMA FAALIYETI

Islem Basamaklar1

Oneriler

Proje editor programini
kullanarak yeni bir
Silverlight projesi

» File->New Project->Silverlight->Silverlight
Application

olusturunuz.
» Projenin web klasoriiniin iizerinde sag tus meniistinii
» Projenin web tarafina bir goriintiileyiniz.
xaml dosyasi ekleyiniz. » Add->New Item->Silverlight-> Silverlight 1.0

Javascript Page

Xaml dosyasi igerisine
yiikleme animasyonunu
icin gerekli xaml
kodlarin1 yaziniz.

> Uc adet Rectangle ve iki adet TextBlock kullanarak
asagidaki gibi bir tasarim yapabilirsiniz (Uzerinde 0
yazan TextBlock ismi “textBlock1” ve alttaki kiigiik
kirmiz1 dikdortgenin adi “kutu” olmalidir.).

Projenin html uzantili
olan dosyasini baglangic
sayfas1 yapimniz.

» Sayfa iizerinde sag tusa tiklayimiz.
» Set As Start Page komutunu tiklayiniz.

Projenin html kodlarini
goriintiileyiniz.

<object></object>
blogunun i¢ine yan
taraftakine benzer

parametre tanimlamalarini

yapiniz (Kendi
olusturdugunuz sayfa
adina gore).

<param
name="splashscreensource"value="yukleme.xaml"/>
<param name="onSourceDownloadProgressChanged"
value="onSourceDownloadProgressChanged"/>

JavaScript kod blogu

i¢indeki kodlarin altina
yan taraftaki fonksiyon
tanimlamasini yapiniz.

function onSourceDownloadProgressChanged(sender,
eventArgs)

sender.findName("textBlockl1l").Text =
Math.round((eventArgs.progress * 100),
0).toString();
sender.findName("cubuk") .Width =
eventArgs.progress*100;

}

Projeyi calistirimiz.

» F5 tusunu kullaniniz.
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KONTROL LiSTESI

Bu faaliyet kapsaminda asagida listelenen davranislardan kazandiginiz beceriler igin
Evet, kazanamadiginiz beceriler i¢in Hayir kutucuguna (X) isareti koyarak kendinizi

degerlendiriniz.

Degerlendirme Olgiitleri

Evet

Hayir

1. Yikleme sayfalarinin islev ve gerekliligini kavradiniz mi1?

2. HTML-JavaScript-Silverlight ortamlar1 arasindaki iligkiyi
kavradiniz mi?

3. Yiikleme sayfasindan asil Silverlight uygulamasina gegisi
saglayabildiniz mi?

DEGERLENDIRME

Degerlendirme sonunda “Hayir” seklindeki cevaplarinizi yeniden gbézden gegiriniz.
Kendinizi yeterli buluyorsaniz 6grenme faaliyetini tekrar ediniz. Biitiin cevaplariniz “Evet”

ise “Ol¢me ve Degerlendirme” béliimiine geciniz.
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Asagidaki sorular dikkatlice okuyunuz ve dogru secenegi isaretleyiniz.

1. Yikleme sayfasi tasariminda kullanilan teknolojilerin isleyis sirast hangisinde dogru
verilmistir?
A) Silverlight-HTML-JavaScript
B) JavaScript-Silverlight-HTML
C) HTML-Silverlight-JavaScript
D) HTML-JavaScript-Silverlight

2. Bir yiikleme sayfasinin bulunmasi gereken yer asagidakilerden hangisidir?
A)Silverlight projesi B) Silverlight Web projesi
C) Debug klasorii D) Herhangi Bir XAML dosyast

3. Asagidakilerden hangisi yiikleme isleminin tamamlanip tamamlanmadigini denetleyen
JavaScript olayidir?
A) onError B) splashscreensource
C) onSourceDownloadComplete D) onLoad

4. Asagidakilerden hangisi HTML dosyasi igerisinde yiikleme sayfasi kaynagim
belirleten parametredir?

A) object B) src
C) splashscreensource D) id

5. Silverlight uygulamasinin veri aktariminin denetlenmesi gibi sistem kaynaklartyla
ilgili bir gérevi yerine getirmek i¢in araci olarak kullandigi ortam hangisidir?
A) JavaScript B) HTML C) XAML D) XML

6. Kullanicinin  uygulamayla ilgili sorunlardan haberdar olmas1 ve ¢oziime
yonlendirilmesi isine ne ad verilir?
A) Hata Diizeltici

B) Hata Yonetimi
C) Hata Ayiklama
D) Hata Yakalama

DEGERLENDIRME

Cevaplarimizi cevap anahtartyla karsilastirrmiz. Yanlis cevap verdiginiz ya da cevap
verirken tereddiit ettiginiz sorularla ilgili konular1 faaliyete geri donerek tekrarlayimiz.
Cevaplarimizin tiimii dogru ise bir sonraki 6grenme faaliyetine geginiz.
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OGRENME FAALIYETIi-2

( AMAC )

Gelismis /nternet uygulamalarinda arayiiz hazirlamay 6greneceksiniz.

(ARASTIRMA )

> Masaiistii uygulamalarinda ya da internette gezinirken bilgisayara bir komut
vermek ya da bir bilgi girmek i¢in kullandiginiz elemanlarn bir listesini
yapiniz.

> Bir uygulamanin kullamiminda arayiiziin etkisini arkadaslariniza ve size ait

tecriibeleri derleyerek degerlendiriniz.

2. KULLANICI ARAYUZU OLUSTURMA

XAML tabanli gelismis internet uygulamalarinda butonlar, metin kutulari, liste
kutular1 gibi kontrollerden faydalanarak c¢esitli arayiiz tasarimlar1 yapabilmekteyiz.

Ana Sayfa
Hakiamizda

Benim Yazlanm

i ' Twitter
Ak
Google

Resim 2.1: Cesitli arayiiz elemanlari

2.1. Olaylar

Gelismis Internet uygulamalar1 hazirlarken en ¢ok kullanacagimiz programlama
kavramlarindan Dbirisi “olay”dir. Olaylar (Event), belirli durum veya eylemlerin
gerceklesmesi halinde yiiriitillecek islemleri belirleyen yapilardir. Ornegin bir kontrole
tiklanmasi, bir metin girilmesi, bir nesnenin tagmmasi

Tasarim editoriinde bir kontrole olay eklemek i¢in 6ncelikle nesne segilir. Ekranin sag

kismindaki Properties penceresinde yer alan Events diigmesine tiklayarak o nesneye iliskin
kullanilabilecek olaylar listelenir.
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Properties ~ 1 x

Button buttonl

“f Prope..  Events

Search ®

BindingVal... [

|
GotFocus
IsEnabledC...
KeyDown

C
C
C:
Keylp [

Resim 2.2: Buton olaylari
Kontrollere ait olaylar1 programlayabilmek igin kontrollere isim verilmesi
gerekmektedir.

XAML tabanli uygulamalarda kontrollerin tiimii i¢in kullanilan ortak olaylar oldugu
gibi yalnizca bazi kontrollere 6zgii olaylar da mevcuttur.

Events panelinde kullanilmak istenen olayin sag yaninda bulunan alana ¢ift tiklanarak
olay olusturulur. Boylece olayla ilgili kodlamanin yapilacagi C# kod sayfas1 goriintiilenir.

private void buttonl Click(object sender, RoutedEventhrgs e)
{ |
}

Resim 2.3. Click olayina ait C# kod blogu

Olay i¢in hazirlanan metod igerisine ilgili olay gerceklestiginde yiiriitiilmesi istenen

kodlar yazilir.
private void buttonl Click(object sender, RoutedEventhrgs e)
{
buttonl.Width = buttonl.Width + 583
}

Resim 2.4: Click olayina ait 6rnek C# kodu

XAML tabanhi gelismis internet uygulamalar igerisinde farkli ihtiyaglar i¢in ¢ok
sayida olay tanimlanmustir. Arayliz programlarken en ¢ok kullanilan bazi olaylar ve kisa
acgiklamalar1 Tablo 2.1°de verilmistir.
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Click Kontrol iizerine tiklanmasiyla tetiklenir.

MouseLeftButtonDown | Farenin sol tusuna her basildiginda tetiklenir.

MouseL eftButtonUp Ba_s111 'durumdaki farenin sol tusu her birakildiginda
tetiklenir.

MouseMove Fare hareket ettikge tetiklenir.

KeyDown Klavyeden herhangi bir tusa basildiginda tetiklenir.

GotFocus Kontrol segili héle getirildiginde tetiklenir.

MouseEnter Fare kontrol lizerine geldiginde tetiklenir.

MouseL eave Fare kontrol {izerinden ayrilinca tetiklenir.

Tablo 2.1: Silverlight icerisinde en ¢ok kullanilan olaylar ve tanimlar:

2.2. Metodlar

Gelismis Internet uygulamalar1 tasarlarken kullandigimiz her kontroliin yerine
getirebildigi kendisine 6zgii islemler bulunur. Bu islemlere “metod” adi verilir.

Tasarim editoriinde C# kod sayfasinda ilgili kontrole verilen isim yazildiktan sonra
“.”(Nokta) ayraci konuldugunda IntelliSense 6zelligi o kontrol i¢in mevcut bulunan ozellik,
olay ve metodlari listeler. Bu liste icerisinde Sekil 7.1°de gosterilen simge metodlar1 ifade
etmektedir.

} “F Background -
# BindingValidationError
private V¢ BorderBrush
{ 7 BorderThickness
“F CacheMode

B @ CaptureMouse
i 2% ClearValue ]
rivate w¢ F Chck
f[’ “F ClickMode
ornekt =) Clip bl ]
ornekBtn.I

1

Resim 2.5: Metod ekleme
2.3. Siiriikle-Birak islemi

Sayfa tasariminda kullandigimiz kontrolleri sayfa iizerinde istenilen bolgeye
tagtyabilmek icin ilgili nesnenin MouselLeftButtonDown, MouselLeftButtonUp ve
MouseMove olaylarini kullanmaliyiz.

Siiriiklenecek nesnenin bir canvas igerisinde bulunmasi gereklidir. Program koduyla
canvas icerisindeki nesnelerin iist konum Ozelligini degistirmek i¢in Canvas.SetTop( )
metodunu kullanmaliy1z. Benzer sekilde bir kontroliin iist konum degerini elde etmek igin
Canvas.GetTop() metodu kullanilir.

Kontrollerin sol konum degerlerini almak igin Canvas.GetLeft() metodu kullanilir.
Ayrica sol konum degerlerini ayarlamak i¢in Canvas.SetLeft() metodu kullanilmalidir.
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Ornek: Sayfa iizerinde bulunan bir elips nesnesinin fareyle istenen
taginabilmesi i¢in gerekli olay ve metodlari kullanalim.

bolgeye

bool surukleniyor = false;
Point ilkkonum;

private void ellipsel_MouseLeftButtonDown(object sender,
MouseButtonEventArgs e)
{

surukleniyor = true;

ilkkonum = e.GetPosition(ellipsel);

}

private void ellipsel_MouseMove(object sender, MouseEventArgs e)
{

Point yenikonum=e.GetPosition(ellipsel);

if (surukleniyor)

{
Canvas.SetTop(ellipsel,Canvas.GetTop(ellipsel)+(yenikonum.Y-
ilkkonum.Y));

Canvas.SetLeft(ellipsel, Canvas.GetLeft(ellipsel) + (yenikonum.X -
ilkkonum.X));

}

}

private void ellipsel_MouselLeftButtonUp(object sender,
MouseButtonEventArgs e)

{
}

surukleniyor = false;

Bu program kodlariin ¢alisma yontemi ise soyledir:

Kullanic1 elipsin iizerinde farenin sol tusuna bastigi anda MouselLeftButtonDown
olay1r tetiklenir. Bu olay igerisinde surukleniyor degiskeni true yapilir ve farenin elips

iizerindeki koordinatlar1 ilkkonum isimli degiskene alinir.

Kullanic1 fareyi her hareket ettirdiginde farenin elips tizerindeki koordinatlari
yenikonum isimli degiskene alinir. Ve ayrica surukleniyor degiskeni kontrol edilir. Eger bu
degisken true ise farenin sol tusu basili haldeyken hareket ettiriliyor demektir. Bu sarta bagh

olarak yenikonum ile ilk konum arasindaki fark kadar elipsin konumu kaydirilir.
Kullanici fareyi biraktiginda surukleniyor degiskeni false yapilir.
Ekran goriintiisii: Nesnenin fareyle siiriiklenebildigi goriilecektir.

Resim 2.6: Ekran goriintiisii
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Uygulama: Yonergeleri takip ederek Silverlight ile temel siiriikle-birak islemlerini
iceren bir geligmis internet uygulamasi hazirlayiniz.

Islem Basamaklar Oneriler
» Proje editor
programini

kullanarak yeni bir » File->New Project->Silverlight-> Silverlight Application
Silverlight projesi
olusturunuz.

» MainPage.xaml
sayfasi lizerine bir > I¢ dolgu rengi ve boyutlarini gerekli sekilde ayarlayiniz.
elips ekleyiniz.

» Elipsin » Elips secildikten sonra Properties panelindeki Events
MouseLeftButtonDo boliimiini kullaniniz.
wn metodunu
olusturunuz.

private void ellipsel_MouseLeftButtonDown(object

o ) sender, MouseButtonEventArgs e)

» Metod igine gerekli | {
kodlar1 yaziniz. surukleniyor = true;

konum = e.GetPosition(ellipsel);

}

> Elipsin MouseMove » Elips secildikten sonra Properties panelindeki Events

metodunu o e o
boliimiinii kullaniniz.
olusturunuz.
private void ellipsel_MouseMove(object sender,
MouseEventArgs e)
{
Point mesafe=e.GetPosition(ellipsel);
o ) if (surukleniyor)
» Metod igine gerekli {
kodlar1 yaziniz. Canvas.SetTop(ellipsel,Canvas.GetTop(ellipsel)+(mesafe.Y-
konum.Y));
Canvas.SetLeft(ellipsel, Canvas.GetLeft(ellipsel) +
(mesafe.X - konum.X));
}
}
» Elipsin » Elips secildikten sonra Properties panelindeki Events
MouseL eftButtonUp boliimiini kullaniniz.
metodunu
olusturunuz.

private void ellipsel_MouselLeftButtonUp(object
sender, MouseButtonEventArgs e)

{

}
» Projeyi ¢alistiriniz. » F5 tusunu kullanabilirsiniz.

» Metod igine gerekli

kodlart yaziniz. surukleniyor = false;
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KONTROL LiSTESI

Bu faaliyet kapsaminda asagida listelenen davranislardan kazandiginiz beceriler igin
Evet, kazanamadiginiz beceriler i¢in Hayir kutucuguna (X) isareti koyarak kendinizi
degerlendiriniz.

Degerlendirme Olgiitleri Evet Hayir
1. Olay ve metod kavramlarini kavrayabildiniz mi?

2. Kontrollere olay ekleme islemini ger¢eklestirebildiniz mi?

3. Siiriikle-Birak iglemini sorunsuz bir sekilde ger¢eklestirebildiniz
mi?

DEGERLENDIRME

Degerlendirme sonunda “Hayir” seklindeki cevaplarimizi bir daha gézden gegiriniz.
Kendinizi yeterli gormiiyorsaniz 6grenme faaliyetini tekrar ediniz. Biitlin cevaplariniz
“Evet” ise “Ol¢me ve Degerlendirme” boliimiine geginiz.
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Asagidaki sorularn dikkatlice okuyunuz ve dogru secenegi isaretleyiniz.

1. Asagidakilerden hangisi XAML tabanli zengin internet uygulamalarinda kullanilan bir

olaydir?
A) MouseMove B) Row
C) Column D) Width

2. Birnesneyle ilgili belirli durumlarda gergeklestirilecek islemlerin
tanimlanacagi kod sayfasina erismek icin editor icinde hangi kisim kullanilir?

A) Objects AndTimeline paneli B) Events paneli
C) Properties penceresi D) Solution Explorer sekmesi
3. Bir nesnenin sol konum degerini ayarlamak igin asagidaki metodlardan hangisi
kullanilir?
A) Canvas.SetLeft() B) Top
C) Left D) Canvas.SetTo()
4. Bir nesnenin iist konum degerini ayarlamak i¢in asagidaki metodlardan hangisi
kullanilir?
A) Top B) Left
C) Canvas.SetTop() D) Canvas.SetLeft()

5. Biir nesnenin iizerinde farenin hareket ettirilmesi durumunda asagidaki

olaylardan hangisi ¢aligir?
A) Click B) MouseLeave C) MouseMove D) MouseOut

DEGERLENDIRME

Cevaplarimizi cevap anahtariyla karsilastiriniz. Yanlis cevap verdiginiz ya da cevap
verirken tereddiit ettiginiz sorularla ilgili konular1 faaliyete geri donerek tekrarlayiniz.
Cevaplarimizin tiimii dogru ise “Modiil Degerlendirme”’ye geginiz.
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MODUL DEGERLENDIRME

Asagidaki sorularn dikkatlice okuyunuz ve dogru secenegi isaretleyiniz.

1.  Yikleme sayfasinin XAML projesine dahil edilmesinde hangisi kullanilir?

A) C# C) HTML
B) XAML D) XML
2. Asagidakilerden hangisi yiikleme sayfasi olarak kullanilmaya uygun degildir?
A) JOption sayfasi
B) XAML sayfasi

C) HTML sayfas1
D) Grid kontrolii

3 Asagidakilerden hangisi bir siirtikle-birak isleminde kullanilan temel olaylardan birisi

degildir?
A) MouseL eftButtonDown C) MouseLeftButtonUp
B) MouseEnter D) MouseMove

4.  Asagidakilerden hangisi XAML tabanli gelismis /nternet uygulamalarinda hata
yonetimi i¢in kullamlamaz?
A) Bir XAP dosyasi C) Visual Studio 2010 Debugger
B) C# fonksiyonlari D) JavaScript fonksiyonlari

Asagidaki ciimlelerin basinda bos birakilan parantezlere, ciimlelerde verilen
bilgiler dogru ise D, yanhs ise Y yazimiz.

5. () S6z diziminden kaynakli sorunlar derleme hatasi olarak isimlendirilir.
6. () Visual Studio 2010 igerisinde entegre bir Silverlight hata ayiklayicist mevcuttur.
7. () Uygulamanin kullaniciyla etkilesim kuran kismina arayiiz ad1 verilir.

8. () Kontroller igerisinde bulunduklari Layout kontroliinden bagimsiz olarak daima
aym Ozellikler ile tanimlanir.

DEGERLENDIRME

Cevaplarinizi cevap anahtariyla karsilastiriniz. Yanlis cevap verdiginiz ya da cevap
verirken tereddiit ettiginiz sorularla ilgili konular1 faaliyete geri donerek tekrarlayiniz.
Cevaplarimizin tiimii dogru ise bir sonraki modiile gecmek i¢in 6gretmeninize bagvurunuz.
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CEVAP ANAHTARLARI

OGRENME FAALIYETIi-1’iIN CEVAP ANAHTARI

olu|s|w|N|-
0> 0|0|m|o

OGRENME FAALIYETIi-2°’NiN CEVAP ANAHTARI
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MODUL DEGERLENDIRME’NIN CEVAP ANAHTARI
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Yanls
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